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Micro Focus Academic Program 9.0 -
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Overview

The Micro Focus Academic Program brings contemporary software development tools and technologies to
COBOL development helping to bridge the gap between the old and the new.

COBOL applications still run many of the world’s business systems, therefore teaching the COBOL
language is a great way to prepare your university's students for a robust IT career in today’s economy.

The Micro Focus Academic Program is designed to support the education and use of the COBOL language
within the academic setting. This program supports our academic partner community through the use of
our COBOL development tools and materials within the classroom.

This program will enable your university to quickly join this growing league of similar academic
organizations in support of the promotion and education of the COBOL language.

Welcome! We're excited to have you join our growing academic community.

Product Description
The Micro Focus Academic Program Edition package comprises the following products:

« Visual COBOL - delivers the richest development experience for COBOL programming. On Windows,
Visual COBOL is available for use with Microsoft's Visual Studio or with the Eclipse integrated
development environments. On UNIX or Linux, it is available for use with Eclipse. Visual COBOL
supports the development and deployment of both JVM COBOL and .NET COBOL, and of native
COBOL applications.

Variants of Visual COBOL include:

« Visual COBOL for Visual Studio 2022
« Visual COBOL for Eclipse (Windows)

« Enterprise Developer - a contemporary development suite for Microsoft Visual Studio or for Eclipse that
enables mainframe developers to maintain, develop and modernize mainframe applications regardless
of whether these are to be deployed back on the mainframe or onto an alternative platform. Enterprise
Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM DB2,
IBM z/OS file formats and common batch utilities including SORT. This means you can develop and
maintain the core mainframe online and batch applications under Enterprise Developer, then deploy
them back on the mainframe or migrate them onto one of the Micro Focus production platforms
available on UNIX, Linux, or Windows. Variants include:

« Enterprise Developer for Visual Studio 2022
« Enterprise Developer for Eclipse

Micro Focus Academic Program differs from the full version of these products in a number of ways. The
differences are:

* You cannot deploy applications on other machines, so Micro Focus COBOL Server and Enterprise
Server are not supplied.
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Note: Micro Focus Academic Program is supplied for Academic use only. It is not to be used for any
commercial purposes. You must be a registered Micro Focus Academic Program Partner in order to
use this software.

For more information, follow the link in the Electronic Product Delivery email for the End User License
Agreement.

Reporting Issues

* For the latest information and discussions on this product, or to report issues, visit the Micro Focus
Community Web site.

f Note:

» This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

¢ Check the Product Documentation section of the Micro Focus Customer Support Documentation
Web site for any documentation updates.

Upgrading from earlier Micro Focus products

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Visual COBOL can automatically relink the existing executable or .dll to the new version of the C
run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar providing an option for you to choose and relink the project.

If you are using Eclipse, Visual COBOL can automatically relink existing projects created with Visual
COBOL earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the Problems
view that the project requires relinking. It then offers a Quick Fix action for you to execute that will link your
project with the most recent version of the Run-Time System.

What's New

This What's New? document covers some of the new features and functions in the latest release of the
Micro Focus Enterprise Product Suite. Updates apply to the following products:

* Micro Focus Enterprise Developer which provides a contemporary development suite for developing
and maintaining mainframe applications, whether the target deployment is on or off the mainframe.

* Micro Focus Enterprise Test Server which provides a comprehensive test platform that takes
advantage of low cost processing power on Windows environments, to supply scalable capacity for
testing z/OS applications without consuming z/OS resources.

Micro Focus Academic Program 9.0 - Release Notes | 5
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* Micro Focus Enterprise Server which provides the execution environment to deploy fit-for-purpose
mainframe workload on Linux, UNIX and Windows (LUW) environments on IBM LinuxONE (IFLs),
standalone servers, virtual servers, or the Cloud.

* Micro Focus Enterprise Server for .NET which provides the execution and modernization platform to
deploy fit-for-purpose mainframe workload on a scale-out .NET infrastructure and the Azure Cloud.

This document helps you to quickly understand the new capabilities within the 9.0 release.
Enhancements are available in the following areas:

» Learn Micro Focus™ Learn COBOL extension and Micro Focus™ COBOL Fundamentals Course
* Micro Focus Enterprise Extension for Visual Studio Code
e Micro Focus COBOL Extension for Visual Studio Code

¢ .NET Support

« Application Workflow Manager

* AppMaster Builder

« COBOL Language

e Compiler Directives

« Data Modernization Advice

« Database Connectors for Visual COBOL

» Debugging

» Eclipse Integration

e Enterprise Server

» Enterprise Server Common Web Administration (ESCWA)
» Enterprise Server Security

e HCO for PostgreSQL

e IMS support

* Interface Mapping Toolkit

e JCL Support

e Mainframe Access

¢ Micro Focus Unit Testing Framework

¢ OpenESQL

e PL/I Support

e Terminal Emulation

e Tracing

* Visual Studio Integration

Learn Micro Focus™ COBOL Extension for Visual
Studio Code and Micro Focus™ COBOL Fundamentals

Course
Back to Top

Micro Focus has released a new video-based training course in COBOL, Micro Focus™ COBOL
Fundamentals Course. The course teaches the fundamentals of the COBOL language, introduces the
Micro Focus™ COBOL syntax, and usage of Micro Focus COBOL tools.

The course is ideal for developers familiar with C, Java, or .NET who want to learn COBOL. It doesn't
matter what language you know, as long as you have experience of standard programming concepts, this
course is for you.

A new Learn Micro Focus™ COBOL Extension for Visual Studio Code is available. The extension comes
with the training materials for the COBOL training course. For information about the COBOL course, and
the Learn Micro Focus™ COBOL Extension for Visual Studio Code, visit www.cobol.com.
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i Note: This extension is not included with the Visual COBOL installer.

Micro Focus™ Enterprise Extension for Visual Studio
Code

Back to Top

The following features are now available in the Micro Focus™ Enterprise Extension for Visual Studio Code
when you use it with Visual COBOL 9.0:

« A PL/I Language Server is available. This enables the following advanced features in the PL/I editor -
Find All References, Peek, Outline view, collapsible regions, Rename, Navigate To, background error
reporting, variable highlights.

A new button, &, Debug PL/I Program or Run PL/I Program in the top right corner of the editor, is
present for the current PL/I program.

* You can now specify the PL/I main file context for include files if an include copybooks is referenced in
more than one program.

f Note:

* This extension is not included with the Visual COBOL installer.
» This extensions also installs the Micro Focus™ COBOL Extension for Visual Studio Code.

Micro Focus™ COBOL Extension for Visual Studio
Code

Back to Top

The following features are now available in the Micro Focus™ COBOL Extension for Visual Studio Code
when you use it with Visual COBOL 9.0:

« JVM COBOL debugging
e COBOL notebooks where you can have text and executable blocks of COBOL code in the same file.
» Colorization for COBOL directives files, cobol .dir.

A new button, &, Debug COBOL Program or Run COBOL Program in the top right corner of the
editor, present for the current COBOL program.

« Configuration setting for custom tab stops.

e A Micro Focus COBOL terminal in the TERMINAL pane.

* You can now specify the COBOL main file context for copybooks if a copybooks is referenced in more
than one program.

i Note: This extension is not included with the Visual COBOL installer.

.NET Support

Back to Top

This release provides the following enhancements to .NET support:

e This release installs several NuGet packages each of which contains the assemblies for a specific Micro
Focus functionality. New .NET projects, as well as existing projects you edit or build in 9.0 are linked to a

core package, MicroFocus.COBOL.Runtime.Core, that includes the basic functionality for the projects.
You need to add any additional packages (such as a specific file handler, COBOL Accept/Display etc.)
manually to the projects. The new packages enable better granularity of distributions, and provide more
flexibility and control over what is packaged with the application.

Micro Focus Academic Program 9.0 - Release Notes
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* New SDK version - the Micro Focus SDK version has changed to version 2.1. See Upgrading
existing .NET COBOL project files in your product Help for details on how to upgrade your existing
projects.

Application Workflow Manager

Back to Top
This release offers the following improvements:

* A new Git Function Package - provides tools that support common Git interactions such as Clone, Add,
and Commit. This function package provides tool types to integrate the distributed revision control
system Git into your AWM model and enabling you to build a development workflow that includes Git
version control actions within the AWM Team Developer perspective.

AppMaster Builder

Back to Top
This release includes new functionality to support long and spacey paths. This affects the following:

» 8dot3 short-name creation behavior is no longer required on your computer file systems. See your
Windows documentation for more information about enabling and disabling 8dot3 short-name creation.

* AMB file-tailoring skeleton files no longer require modification (usually these modifications consisted of
enclosing paths within quotes) to use long and spacey file names.

« You must compare and reintegrate any customizations applied to file-tailoring skeleton files used in
earlier versions of AMB into the new skeleton files provided with this release. These files are found in
your %ProgramFiles(x86)%\Micro Focus\Visual COBOL\etc\ispslib directory, and include:

SSMSISP
SSMSDLG
SSMSMFS
SSMCHK
SSMPCOM
SSMSCGEN
SSMCOMP
SSMOXGEN
SSMCBL
SSMMBMS
DVSQL2
DVSQLR
DVSYMS
DVSYMSX
DVBAT
DVVSM?2
DVMAIN
DVJOBVSM
DVJOBDDG
DVJOBIMS
DVJOBSQL
DVCHECK
DVIMS2
DVCOPY
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COBOL Language

Back to Top

This release provides the following new features and enhancements to the COBOL language:
Double-colon, : :, qualification is now available as a qualifier for data names and when dereferencing
pointers.

PERFORM frame local variables - variables that are DECLAREd are now properly scoped. Reentering
the SECTION, whether recursively or after leaving, gives a new instance of such variables. This
provides better locality of data, and helps with writing of better structured code.

Parameterized sections - syntax that allows program sections to accept arguments and return values.

« PERFORM of a SECTION can now pass arguments to that SECTION.

* Arresult can be returned to the code that PERFORMed the SECTION.

» Sections that return a value can be used as functions, in contexts where an identifier is expected.
Compiler can identify platform at compile time - the compile-time constants ___ unix, __ windows,
__dotnet, ___jvm, and __native have been introduced. These can be tested in $if statements to
tailor code to the platform being used.

Enhanced CBL_STRING_CONVERT library routine - CBL_STRING_CONVERT can now convert
strings to and from Base64.

The following enhancements add further support for the IBM Enterprise COBOL version 6.4:

User-defined functions - user-defined functions are now available in an Enterprise COBOL dialect for
version 6.4 compatibility. Reference the product Help, General Reference > COBOL Language
Reference > Part 3. Additional Topics > Additional Dialect Support > Enterprise COBOL Syntax Support
> User-Defined Functions under ENTCOBOL dialect. A new Compiler directive, MANAGED-FNC-
PARAM-BY, enables you to specify whether the managed behavior of numeric function parameters
should default to BY VALUE or BY REFERENCE.

Enhanced mechanism for interoperation between Java and COBOL - The COBOL and Java
interoperability has been enhanced to extend the capabilities of your COBOL applications with Java. It
removes the need to write object-oriented (OO) COBOL, as your native COBOL and Java programs can
now interoperate in the following scenarios:

e COBOL programs can be marked as JAVA-CALLABLE, meaning that they can be called from Java
as though they were Java static methods.

e COBOL program can call Java static methods using the java.class.method call.

e COBOL data can be shared with Java programs by marking it as JAVA-SHAREABLE.

Comprehensive support for automatic conversion between a wide variety of popular Java data types
and their corresponding COBOL types so that parameter passing and returned value handling require
no special processing in user code.

Compiler Directives
Back to Top

This release provides the following enhancements.

A new mechanism for setting Compiler directives (Technology Preview):

Common directives files - this release introduces common directives files, directives.mf files, that
enable you to automatically provide all required directives needed to compile multiple COBOL and
Mainframe Subsystem applications without having to specify the directives individually. This feature is
not available for Assembler or IMS.

Micro Focus Academic Program 9.0 - Release Notes
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Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use
and it is not supported as such. Furthermore, Micro Focus does not guarantee that this feature will
be delivered at a GA level and if it is, then the functionality provided might differ considerably from
this technology preview.

New Compiler directives:

ALPHA-LIT-CONT - determines whether the right margin or the end-of-line is used to delimit the
continuation of a non-numeric literal.

DECLARE - defines the behavior of locally declared variables.

ILEXPOSEALPHA/ILEXPOSEGROUP - these two directives can expose alphanumeric or group items
passed by value to parameterized sections or methods in .NET COBOLJVM COBOL programs as byte
arrays (the default is to expose as string objects).

ILSTRINGLOAD - where .NET COBOLJVM COBOL programs with a very large number of distinct
alphanumeric literals cause internal limits to be exceeded, use this directive to create these literals in a
backing file, which can then be converted to strings at run time.

MANAGED-FNC-PARAM-BY - determines whether user-defined function parameters are passed BY
VALUE or BY REFERENCE by default when compiled with ILGENJVMGEN.

INITIAL - determines how Working-Storage is initialized for programs marked as IS INITIAL.

A family of new Compiler directives has been introduced to support the new mechanism for interoperation
between Java and native COBOL.:

JAVA-SHAREABLE - use the JAVA-SHAREABLE ON and JAVA-SHAREABLE OFF directives to bracket
one or more WORKING-STORAGE data items to indicate that they are to be made read and write
accessible from Java applications interoperating with this COBOL program.

JAVA-CALLABLE - instructs the Compiler to make the COBOL program automatically callable from
Java.

JAVA-GEN-PROGS, JAVA-GEN-STRG, JAVA-OUTPUT-PATH, and JAVA-PACKAGE-NAME - control the
behavior of COBOL programs that interoperate with Java through the JAVA-CALLABLE or JAVA-
SHAREABLE directives or by calling Java static methods using the CALL statement.

Data Modernization Advice
Back to Top

The product Help now includes advice on moving your COBOL data files, such as flat files, VSAM, indexed
or sequential files, etc. to a relational database (RDBMS). The documentation lists the solutions included in
Visual COBOL that enable you to achieve this, including advice on the best option for your application as
well as performance considerations.

Database Connectors for Visual COBOL

Back to Top

This release provides the following enhancements:

Better control of permissions granted on newly created tables.

When creating a table, the SQL Server interface also creates an index, and grants loose permissions to
everyone via the A-MSSQL-GRANT-PERMISSIONS and A-MSSQL-GRANT-USERNAME configuration
variables with their default values. If database permissions are not set to allow these loose permissions,
the GRANT statement fails, causing OPEN OUTPUT to fail.

See A-MSSQL-GRANT-PERMISSIONS and A-MSSQL-GRANT-USERNAME for details.
Increased table and column name sizes for ODBC

Micro Focus Academic Program 9.0 - Release Notes



To accommodate the number of characters the ODBC driver allows, this release increases the allowable
table name and column name sizes for ODBC via two new ODBC configuration file variables. For
details, see A ODBC_MAX_COLUMNNAME_LEN and A_ODBC_MAX_ TABLENAME_LEN.

« Support for all currently available versions of the Microsoft SQL Server ODBC Driver, which have been
tested through version 18.

See the following Configuration Variables topics for details:

A _MSSQL_ODBC_DRIVER_NAME

A_MSSQL_ENCRYPT_CONNECTION

A MSSQL_TRUST_SERVER_CERTIFICATE

A_MSSQL_EXTRA_CONNECTION_INFO

e The A_MSSQL_IDENTITY_TYPE configuration variable has been added to enable you to configure the

identity column to be a larger type, and to store a 64-bit value internally. Set
A_MSSQL_IDENTITY_TYPE to a string value that represents a fully qualified data type for your
database. The default is:

A_MSSQL_IDENTITY_TYPE="numeric(9,0)"

Debugging

Back to Top

This release provides the following new features:

« In Visual Studio, you can now debug .NET COBOL projects in WSL.

* In Eclipse, new Debug and Run configurations have been added for debugging and running COBOL/
Java Interoperability applications. These enable you to debug COBOL programs calling Java static
methods. To debug Java code calling a COBOL program, you must create a Java Application launch
configuration and manually define the VM arguments property -Djava.library.path with a value
representing the output path to the native library produced from the COBOL builder.

Eclipse
Back to Top

Enhancements are available in the following areas:
Eclipse IDE:

» Eclipse 4.24 (2022-06) support, which is shipped and installed with Visual COBOL. Versions of Eclipse
prior to this one are not supported.

* Exporting code coverage results - an option has been added to the Code Coverage view to allow you
to export the current code coverage results to a - tcz file.

e The Problems view now displays a sequence number column.

* A new project template is available for COBOL/Java interoperability applications. The project enables
you to compile both COBOL and Java sources at the same time.

COBOL editor:

* Auto-indenting on end-*.

* Collapsible regions for EVALUATE statements, and for 01 group items - a hew option, Enable folding
for group level items, has been added to the Eclipse preferences (Window > Preferences > Micro
Focus > COBOL > Editor > Folding).

* Local variables support.
« Parameterized sections - support is available in the editor for parameterized sections.

» Paste JSON as COBOL classes - you can now copy JSON data and do a Paste JSON As Classes into
a JVM COBOL file. This generates COBOL classes which enable you to deserialize the data in those
classes.

Micro Focus Academic Program 9.0 - Release Notes
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A Quick Fix is available for end of scope termination. To enable this, your project must have the
NOIMPLICITSCOPE Compiler directive set, and error level to warning as errors.

Renumber lines on save - line numbers can be automatically applied to a source file when it is saved,
by selecting Perform line numbering on save from Window > Preferences > Micro Focus > COBOL
> Editor > Line Numbering.

Case preference for COBOL keywords on code clean up. A new preference in the code clean up profiles
enables you to convert all COBOL keywords to uppercase or lowercase, if required.

Enterprise Server
Back to Top

This release provides the following enhancements:

A new casverify command-line utility is available. This utility enables you to verify the configuration of
a specified enterprise server region without attempting to start it, and also enables you to create
immediate diagnostics information in JSON or human-readable output. Verification stages are modular,
enabling you to specify which validation checks to run.

You can now list job steps to enable users to perform advanced restarts. Job steps can be output to
JSON by specifying casout /%jnumber or output to a table by specifying casout /%tnumber. See
casout for more information.

Visual COBOL CICS now supports the MAPPINGDEYV option of SEND MAP and RECEIVE MAP
commands.

Application diagnostic reporting now enables you to collect JCL process failures. See Application
Diagnostic Reporting for Enterprise Server for more information.

Enterprise Server Common Web Administration
(ESCWA)

Back to Top

Enhancements are available in the following areas:

Accessibility improvements - provide improved compliance with 508 and WCAG 2.1 standards.

API, version 2 extensions - includes updated versions of some of the existing API version 1 endpoints,
and has been extended to contain more endpoints.

Merged Archived Spool - you can now configure an enterprise server region to view a merged archived
spool in the Ul. You can view multiple archived spools from a single region, and view old spool
information for multiple jobs that have ran under a previous name

Page search facility - you can now search for a page that contains a specified search string. This
enhancement is part of the WCAG 2.1 requirements for accessibility.

PAC clients - the ESCWA Ul lists all TN3270 clients connected to a PAC. This enables you to administer
and monitor clients across the entire PAC from a single PAC region.

TLS-enabled Redis connections. ESCWA now supports administering and monitoring PACs with a TLS
Redis SOR.

Enterprise Server Security
Back to Top

This release provides the following new features and enhancements:

Demo CA - the component has been completely redesigned and is now included as part of Visual
COBOL. Demo CA supports multiple installations, uses up-to-date cryptographic support, and
generates modern version 3 certificates with SANS, PKIDs, AKIDs, etc. signed by an intermediate CA.
Demo CA is now easier to use and has improved interoperability with third-party SSL/TLS systems.
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Note: Micro Focus strongly recommends that Demo CA is only used for SSL/TLS development
and testing and is not intended for use in a production environment.
« esfupdate support for the Vault Facility - the esfupdate utility now supports the use of the Vault
Facility for credentials it needs to connect to MFDS.

e OpenSSL 3.0 - OpenSSL has been updated to use the current Long Term Supported OpenSSL
cryptographic library.

* VSAM External Security Manager (EAP) - the VSAM ESM Module is a new option for Enterprise Server
security which is simpler and more convenient than using LDAP-based security. The VSAM ESM
Module provides a security manager for Enterprise Server which keeps security data in COBOL data
(VSAM) files. It provides many of the features of the MLDAP ESM Module but does not require an LDAP
server or other third-party solution. Security data can be imported from a YAML file, facilitating the
securing of Enterprise Server and the modification of its security data.

/1, Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
%= finalized feature in a future release. Please contact Micro Focus Customer Care if you require
further clarification.

HCO for SQL Server

Back to Top
This release includes support for the following:

« The Define Lists tool in the HCOSS Ul has been enhanced to enable you to select a dependency mode
to use when creating a transfer list. The available modes are:

Default Automatically include all parent objects of the selected object.

Family tree Automatically include all parent objects of the selected table.
Automatically include the child objects of each parent object.
Repeat until no more parents and children are found.

No dependency handling Include the selected table only (do not include any parent or child objects).
* The Transfer Data Tool now includes the start and end date and time for each table transfer.

HCO for PostgreSQL

Back to Top
This release includes support for the following:

» PostgreSQL Global Development Group (GDG) community edition and Amazon AWS via new options
for the TARGETDB directive.

« Migration of z/OS DB2 COBOL programs to PostgreSQL GDG community edition.

/1, Attention: Support for PostgreSQL Global Development Group (GDG) community edition is in Early
*~ Adopter Program (EAP) release status. We intend to provide the finalized feature in a future release.
Please contact Micro Focus Customer Care if you require further clarification.

IMS Support

Back to Top
This release includes the following new features for IMS:

e A new environment variable, ES_IMS_DISPLAY_NEW, has been added to enable the new z/OS /
DISPLAY timestamp output format.

Micro Focus Academic Program 9.0 - Release Notes
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APARM handling has been updated to use EBCDIC APARMSs obtained from EBCDIC applications. In
addition, the APARM positional parameter for DLI has been changed from 19 to 20 to be consistent with
the IBM IMS documentation. The APARM positional parameter for BMP applications remains at 19.
The ES_IMS_APARM_DLI environment variable has been added to enable the APARM handing
behavior of previous releases. See ES_IMS_APARM_DLI for details.

Interface Mapping Toolkit

Back to Top

This release provides the following enhancements:

YAML support is now available for COBOL client generation. OpenAPI schemas can now be in YAML, in
addition to JSON format.

A new option, Refresh Service, has been added to the Web Services and Java Interfaces context
menus in Eclipse. Use the Refresh Service option to update the bitism of the program for an existing
Web Service or Java interface after changing the bitism of the Eclipse project or the COBOL program.

The Interface Mapper user interface for COBOL program-based service interfaces inside Visual Studio
has been updated. The Interface Fields pane available in earlier versions is now represented by two
panes — Interface Fields - Input and Interface Fields - Output. The COBOL Entry Points pane is
situated between these two new panes. The relationships between COBOL entry points and
corresponding interface, COBOL assignment, and reusable fields are depicted visually using arrows.
The panes can be repositioned for easier viewing of arrow relationships.

JCL Support

Back to Top

In this release the security around running programs from JCL jobs has been enhanced to enable you
to limit:

e The location of the programs to load
e Permission to run particular programs based on user ID

This release writes several additional messages to the job log as a JCL job runs, including the location
from which each program is loaded. For example:

JCLCMO3031 Program IDCAMS (MFJAMS) loaded from library
SYS1.LOADLIB

When running one of your own programs, you might see messages such as:

JCLCMO3051 Failed to find program JCLREAD in private libraries
and SYS1.LNKLIB.

JCLCMO3061 Number of SYS1.LNKLIB entries: O.

JCLCMO3031 Program JCLREAD loaded from library SYS2_LOADLIB.

Combined, these three messages indicate that the program was not found in the main program search
path (SYS1.LNKLIB) but has been loaded from the JES Program Path (SYS2.LOADLIB).

For more information about increased JCL security checks including a configuration example, see JCL
Enhanced Security Checks in your product Help. For information about suppressing security check
messages in the job log, see ES_JES HIGHER_SECURITY_LEVEL, also in your product Help.

The MF_SPLJNO_LOCK environment variable has been added. Using this variable, you can change
the process by which the JES engine accesses the job number of a JCL submission to enable
engueuing, which can increase throughput, reduce latency, and reduce disk/file access. For details, see
MF_SPLJINO_LOCK.

Micro Focus Academic Program 9.0 - Release Notes



Mainframe Access
Back to Top

This release includes the following new features for:

Mfdaemon vault usage - the Mfdaemon persistent stored secrets are now stored in the vault.
TAUZCAPP master configuration file location from JCL - MFA Server now enables you to specify the
location for the master configuration file, required by TAUZCAPP, to be performed via JCL instead of
having to edit a REXX script.

Micro Focus Unit Testing Framework
Back to Top

The Micro Focus Unit Test Seam pre-processor (mfupp) has been enhanced to aid the creation of self-
contained unit tests that contain EXEC CICS or EXEC SQL statements. These EXEC statements can be
removed or mocked depending on the requirement of the test case.

The Micro Focus Unit Test Runner has also been enhanced to aid the development of these styles of unit
tests by the addition of new code generation arguments available from the command-line interface.

OpenESQL

Back to Top

In this release, OpenESQL applications now support z/OS DB2 syntax for the community version of
PostgreSQL provided by the Global Development Group (GDG).

PL/I

Back to Top

This release includes enhancements in the following areas:

Open PL/I Compiler:

The following enhancements make the migration of existing applications to new platforms easier. They also

provide an improved functionality when using Open PL/I to develop z/OS applications.

The QUICKSORT and QUICKSORTX built-in functions are now supported.

Restricted expression evaluation now also takes place on AUTOMATIC, DEFINED, and BASED
declarations in addition to STATIC which was added previously.

Support is available for the XMLCONTENT attribute.

The use of the RELEASE statement now implies OPTIONS(FETCHABLE).

Improvements have been made to the support for factored lists used in the INIT attribute of a variable
declaration.

DEFAULT RANGE(*) with no attributes no longer causes the compiler to abort.

Support is available for the FIXEDOVERFLOW condition.

Support is available for the FOFLONASGN, FOFLONDIV, FOFLONMULT, FORCEODD Fixed Decimal
behaviors.

Support is available for validation of FIXED DECIMAL data.

Support has been added for more than 2GB of static data in a single procedure.

Support has been added for placing uninitialized static data in the .BSS section.

Improved diagnostics when passing an array to a procedure which expects an array with differing
attributes.
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* Improved diagnostics when passing CONTROLLED variables as parameters and attributes are in
conflict.

* PL/I FETCH xxxx SET() syntax supports setting a PL/l ENTRY LIMITED.
Open PL/I Debugger:

« Performance improvements on the display of arrays and complex structures.

e Support for arrays declared with negative array bounds.

« Improved debugger performance when watchpoints are set but not active.

« Improved breakpoint clean-up and handling in-between debugger sessions under Enterprise Server.

« Added a message to PLIDUMP to print {cond static external} for CONDITION declarations in the locals
section rather than printing a generic "variable not found" message.

« Added support for decorated symbol/variable names in PLIDUMP on Windows.
* New watch points are now honored after a CONVERSION condition was raised.
« Remote debugging is supported on Solaris (SPARC).

Open PL/I EXEC Preprocessor:

e Itis now possible to specify DB2 LUW OPT guidelines within static SQL.
* The stability of CICS API calls on 64 Bit Solaris (SPARC) has been improved.

Open PL/I Macro Preprocessor:

e The COMMENT built-in function now supports comments larger than 100 bytes in length.
» The -tagmin preprocessor option supports skipping of %SDEBUG; and %RDEBUG; statements when
the replacement text fits on the same line as the macro invocation without wrapping.

« The conditional statements processing has been improved.
Open PL/I Language

Note: These features are in Early Adopter Program (EAP) release status. We intend to provide the
finalized features in a future release. Please contact Micro Focus Customer Care if you require further
clarification.

e Open PL/I now supports ordinals via the DEFINE ORDINAL statement, the ORDINAL attribute for the
DECLARE statement, and the ORDINALNAME, ORDINALPRED, and ORDINALSUCC built-in
functions.

e The DO statement now supports UPTHRU and DOWNTHRU.
Open PL/I Run-Time System:

The following enhancements are available:

» Support for more than 2GB of static data in a single procedure.

« Support for placing uninitialized static data in the .BSS section.

« JSONPUTMEMBER now supports quotation marks within its input.

e Support for the XMLCONTENT attribute.

* The PL/I Run-Time System optionally provides the ability for ERROR to be driven in place of
STRINGRANGE and SUBSCRIPTRANGE.

- PLIDUMP display of the offset within prologue code a signal is received within the prologue of a PL/I
procedure.

e Support for FIXEDOVERFLOW condition.

e Support for FOFLONASGN, FOFLONDIV, FOFLONMULT, FORCEODD Fixed Decimal Behaviors.

e Support for validation of FIXED DECIMAL data.

« The speed for FIXED DECIMAL operations has been improved.

» The stability of CICS API calls on 64 Bit Solaris (SPARC) has been improved.

Product Help:
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* The product Help includes a new section on Open PL/I Conditions.

* A new section, Open PL/I Problem Determination is available. Reference this section to learn how to
mitigate execution, link, and debugger problems, how to use PLIDUMP to resolve issues, and also to
learn about specific PL/I-related information pertaining to the use of the Consolidated Tracing Facility.
This new documentation also includes a list of data items you need to collect before raising a PL/I
problem with Micro Focus Customer Care.

Terminal Emulation
Back to Top

This release provides the following new features.

« Visual COBOL and COBOL Server now incorporate Host Access for the Cloud (HACloud) to provide
3270 emulation. HACloud is the leading Web-based emulator and requires no additional desktop
installation. HACloud replaces the Rumba+ Desktop emulator previously supplied with Visual COBOL.
Customers that have Rumba+ Desktop entitlement can continue to use it within Rumba+ Desktop.

« In this release, Host Access for the Cloud supports session configuration options, as well as creating
and using macros.

« IDE support for Micro Focus Reflection Desktop - you can now select Reflection Desktop as the default
TN3270 display to open from the IDE when you run or debug your TN3270 applications. You can now
play Reflection or Rumba+ Desktop macros with Reflection Desktop.

Tracing
Back to Top

This release provides the following enhancements and new features:

* Improvements have been made to the to the Common Communications Interface (CCl) tracing. CCl
tracing can now be enabled using only the Consolidated Trace Facility (CTF) configuration, without
needing to set trace options in CCL.INI or the environment as well. SSL/TLS trace points have been
added to the CCI CTF trace, making it easier to control. It uses the same mechanism as other
components such as the COBOL RTS. SSL/TLS tracing is now incorporated into CTF, placing all
communications trace output in one place and adding timestamps and other useful information to these
tracepoints. See Enabling CCI Tracing for more information.

Visual Studio

Back to Top
This release provides the following new features:

¢ Converting JSON data to COBOL classes - you can now copy JSON data and use the Paste JSON As
Classes command to copy it into a .NET COBOL file. This generates COBOL classes that enable you
to deserialize the data in those classes.

* Document Outline window for COBOL files.
« Editor support is available for local variables and parameterized sections.

« Format with code cleanup can now be configured to change any keywords in your code to lowercase or
uppercase.

Significant Changes in Behavior or Usage

This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
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The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

.NET Support

» Application Workflow Manager
e AppMaster Builder

e Compiler

« Data Tools

» Documentation

« Eclipse IDE

« Enterprise Server

» File Handling

« HA Cloud

e IMS Support

e JCL Support

* Micro Focus Directory Server
e PL/I Support

e Runtime System

e Setup Issues (Windows)

e Visual Studio IDE

.NET Support
Back to the list

* The 9.0 release installs several .NET 6 NuGet packages each of which contains the assemblies for a
specific Micro Focus functionality. New .NET projects, as well as existing projects you edit or build in 9.0
are linked to a core package, MicroFocus.COBOL .Runtime.Core, that includes the basic
functionality for the projects. You need to add any additional packages (such as a specific file handler,
COBOL Accept/Display etc.) manually to the projects.

Building existing .NET COBOL projects created prior to 9.0 might result in build errors. You can ensure
compatibility by enabling the use of the MicroFocus .COBOL . Runtime metapackage. Alternatively,
you need to add any required NuGet packages manually to the older projects.

See Upgrading existing .NET COBOL project files in the product Help for details on how to upgrade.

Application Workflow Manager
Back to the list

« The related AWM resource (required to perform the resource operation) of the open file is now cached.
02307586 (278005)

AppMaster Builder
Back to the list

< In this release, AMB file-tailoring skeleton files no longer require modification (usually these
modifications consisted of enclosing paths within quotes) to use long and spacey file names. If you use
customized file-tailoring skeleton files, you must compare and reintegrate any customizations applied to
these files into the new skeleton files provided with this release. File-tailoring skeleton files are found in
your %ProgramFiles(x86)%\Micro Focus\Visual COBOL\etc\ispslib directory, and include:

SSMSISP
SSMSDLG
SSMSMFS
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SSMCHK
SSMPCOM
SSMSCGEN
SSMCOMP
SSMOXGEN
SSMCBL
SSMMBMS
DVSQL2
DVSQLR
DVSYMS
DVSYMSX
DVBAT
DVVSM2
DVMAIN
DVJOBVSM
DVJOBDDG
DVJOBIMS
DVJOBSQL
DVCHECK
DVIMS2
DVCOPY

Compiler
Back to the list

« Preprocessor options of more than 256 bytes are now supported, and no longer cause the Compiler to
crash.

02289875 02308713 (272069)

Data Tools
Back to the list

* A new print function available from the File group and the File menu enables you to print the records
shown in the editor.

00367084 (12432)

« An enhancement to the Compare Files function has been added, so that when a comparison is made,
the File Information option shows a statistics overview of the comparison being displayed.

02200177 (222157)

* Inthe Data File Editor, the Compare Files function has been enhanced to allow you to select start and
end columns in which to compare, so only a subset of a record is compared, rather than the entire
record.

02306654 (222159)

* A Quick final page access option has been added to the Preferences dialog box of the Data File
Editor. When selected, large variable sequential files (files > 10,000 records) immediately jump to the
last page of the file when it is opened.

02330923 02365033 02399254 (294002)

Documentation

Back to the list

Micro Focus Academic Program 9.0 - Release Notes | 19



20

To correct an error that sometimes occurred when generating IMTK clients, you must install the latest
version of the Visual Studio MSVS Workload > C++ x64/x86 component.

(400031)
When using the cob command to link PL/I programs targeting Enterprise Server, you must include the -
ImFpdfpz parameter in your link command to avoid problems in multi-step jobs.

02451241 (386064)
FIXEDOVERFLOW conditions are now implemented and will occur when detected.

02163371 (203207)

Eclipse IDE
Back to the list

When creating a new remote project using the SSH file system, the wizard now allows you to create a
new Micro Focus DevHub using SSH connection. (Previously, only the Micro Focus DevHub SSH
Only connection was available.)

(301058)

The Import Server option (from within Server Explorer) is now working correctly with an XML if the
XML file type is known. If the XML file is in an unknown format, an error message is displayed, and
import is not possible.

02345573 (310017)

Enterprise Server

Back to the list

A new option to uninstall a PAC installed on an enterprise server region before deleting the region has
been added to ensure that all PAC components are properly removed.

01907370 (124107)
ESCWA now validates the TLS properties to help prevent errors on entry.

f Note: If ESCWA has an invalid TLS configuration, it reverts to starting without TLS enabled.

01983736 (203178)
In ESCWA, a Stop for IMS MPRs, JES Initiators, and JES Printers now operates correctly.

02311796 (286178)

An issue with not being able to update or navigate the ESCWA UO though the job output in the spool
while it is still running has been resolved.

02322494 (286142)
In ESCWA, the default dashboard can now be modified for all users of a server.

02458710 (392040)

In ESCWA, the FCT Fix Up button has been added to the Active FCT page. See Active FCT in your
product Help for more information.

(374021)

The Job View page in ESCWA now includes a list of job steps that have run during the current
enterprise server region up time.

(347033)

A new configuration property has been added to ESCWA to enable the default language the Ul displays
to be overridden from the user's browser locale.

02227239 02307446 (260128)
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ESCWA now supports TLS enabled Redis repositories.

(306097)
In ESCWA, the Process ID column has been added to the table on the Dynamic Debug page. See
Dynamic Debug in your product Help for more information.

(350029)
In ESCWA, the Spool page can now display multiple Spool Output types.

02503214 (401184)
ESCWA now supports Expiration Dates for Catalog DCB.

02159515 (202201)

In ESCWA, a new PAC Client List page has been added. This page displays a list of PAC members
and associated information. See PAC Client List in your product Help for more information.

(384037)
ESCWA now supports merged archive spool. See Spool in your product Help for more information.

(245050)

An alternate index has been added to the non-recoverable temporary storage file TXTSNR. This is to
enable queues to be returned in alphabetical order when browsing with INQUIRE. When warm starting
non-recoverable TS, if TXTSNR has only a single key then the file will automatically be upgraded to
include the alternate index. If there is a problem during the upgrade process then message CASI1405S
will be written to the console indicating the failure and that the enterprise server region will fail to start.
In this case, the file will either need to be repaired or temporary storage will need to be cold started.

Note: Once TXTSNR has been upgraded it can no longer be used on an older version of the
product that does not contain this fix.

02441509 (389045)

Corrected the spelling for the db_server_name Configuration Manager property. You will need to
update existing 8.0 enterprise server region configurations by either applying any change on the
ESCWA General >Advanced page, or by updating the mfConfigManagerData MFDS property
through the ESCWA API. If this is not performed, the warning message CASCFO071W
Configuration Manager - The requested property (db_sever_name) was not found
will be displayed in the Console log during region initialization. This will not cause any issues if the
Region Database Server Name property was not previously used, or if it was set though the
ES_DB_SERVER environment variable. Otherwise, you will need to reset this property using the above
methods as the previous configuration for Region Database Server Name will not be honored, which
might result in the region failing initialization.

(350050)
A recent change resulted in EXEC CICS TIME(...) expiring immediately. This has been fixed.

02525957 (411120)

In the context of a multi-hop Distributed Program Linking (DPL), if the last stage used the default mirror
transaction, its back-end could be left hanging if a SYNCPOINT was invoked by the upstream partner.
This has been fixed.

02432614 02434318 (377071)

You can now list job steps to enable users to perform advanced restarts. Job steps can be outputted to
JSON by casout /%jnumber. Job steps can be output to a table by casout /%tnumber. See
casout in your product Help for more information.

(401023)

When submitting JCL by content via ESCWA or the JCL command cassub, Enterprise Server will now
authorize the request against a new cassub.content resource class under OPERCMDS. If this class is
not specified then Enterprise Server will revert to existing behavior. See Resource Classes for ESMAC
and Operator Command Security in your product Help for more information.A prototype definition has

been provided in the standard LDIF files shipped with the product.
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(313048)

« A new parameter, —i has been added to the cassub utility. This parameter enables the user to specify a
correlator up to 32-bytes long comprised of ASCII printable characters. The JCL engine will ensure this
correlator has not previously been supplied for a JCL JOB. If a duplicate correlator is detected, the job
submission will be rejected and the previous JOB ID will be returned. See cassub in your product Help
for more information.

02462072 (394004)

e The Redis server supplied with the product is how version 6.2.6.In ESCWA, you must how specify the
Certificate Authority Filepath, Certificate Filepath, and Private Key Filepath properties on the
Advanced Region Properties page for all enterprise server regions that are members of a PAC that
has a TLS-enabled Redis Scale-Out Repository (SOR). See Scale-Out Repositories in your product
Help for more information.

00373756 (12618)

*« When a CICS abend occurs, the 4 letter abend code now appears after the Transaction ID in HSF
records. There has been no change in behavior in the case of an RTS abend, where the transaction
name followed by ABEND still appears.

(246037)
 EXEC CICS INQUIRE TASK LIST now includes dispatchable (queued) tasks in the returned LISTSIZE
parameter.

(365089)
* When performing a DPL targeting a program that had an installed PPT specifying that it was remote,
the use of the TRANSID option on the LINK would be ignored. This has been fixed.

02434323 (386136)
< During XA recovery, if a resource manager reports an in doubt transaction which has no log entry, a
CASXO0040W message will now be displayed in the console.

(425081)

< If a SOR cannot be connected during enterprise server region start up, then the region no longer starts.
Previously, this only applied to the PSOR, but now applies to other SORs which were only used for TS
and TD queues. This change was made because the previous behavior could lead to queues being
written to different locations (SORs or disk) across the PAC. If a PSOR cannot be connected during a
process start up when the region is already running, then the process will be blocked until the
connection can be established. Retries will be attempted at increasingly longer intervals. If a (non-
PSOR) SOR cannot be connected to at process start up when the enterprise server region is already
running, then the process will continue to start up. At queue access time, for a queue that must go to
that SOR, the connection will be retried. If this is unsuccessful then the command will receive an
IOERR.

02399193 (356005)
* ESMAC is disabled by default. ESMAC can be enabled from the Advanced Region Properties page in
ESCWA.

(397027)

File Handling
Back to the list

e The SQL Server ENQ/DEQ implementation has been modified to eliminate any possibility of ENQ
reguest failures occurring due to an intermittent Service Broker problem. The new implementation
introduces a new ENQ stored procedure, and modification of the existing DEQ one to allow it to work
with both the Service Broker and non-Service Broker implementations.

(285197)

« The OPEN EXTEND operation now follows the behavior expected from the OPEN statement as
documented.
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02454638 (386087)
e |CETOOL emulation now supports the RESIZE operator.

(350035)

HA Cloud
Back to the list
* The default color scheme for HA Cloud in Enterprise Server has been updated to cyan on black.

(291041)
* The bundled Host Access for the Cloud (HACloud) Session Server has been updated to 2.7.0.6.

(375012)

» Micro Focus Host Access for the Cloud shipped with Enterprise Developer now offers session
customization options such as connection, and display options, and the functionality to record, and run
macros.

(392026)

IMS Support
Back to the list

« A problem that occurred when a restart call (XRST) referencing a checkpoint ID received checkpoint
data that originated from a different program when a shared checkpoint log file was used and the other
program issued the same checkpoint ID has been fixed. IMS now requires that the name of the
program issuing the XRST must match the name of the program that issued the checkpoint.

(310065)
« The JES alias feature is now supported for IMS application main programs executed from JCL.

02356855 (308032)

JCL Support
Back to the list

« After the release of Enterprise Developer 7.0 PU17 and 8.0, the structure of the M_SPL_JOB.dat file
was updated. If you are upgrading to this release from a release that does not contain the update, you
must rebuild M_SPL_JOB.dat using the following command, and then replace M_SPLJOB.dat with
NEW_M_SPLJOB.dat before executing the merge spool job.rebuild
M_SPLJOB.dat,NEW_M_SPLJOB.dat /r:v344-604

02516141 (407126)

* When performing an IDCAMS REPRO on a cluster with the LIKE parameter set, if the LIKE cluster has
data or index references associated with it, then similar data and index references are now created for
the new cluster.

02358077 (363063)

e If an XA switch module failed while a DSNRLI program was using it then there was no way to
programmatically restart the switch module. This has been corrected. If a module fails with an TX_FAIL
error code (-7) the module can be reassociated with the unit of work by calling DSNRLI IDENTIFY. In
this case the check for the correct DSNRLI call ordering has been suspended so that IDENTIFY can be
called after an TX_FAIL error. The TX_FAIL return code will be passed back to the calling program so
that it is aware of the error. TX_FAIL is -7 and will replace the normal DSNRLI return code (8).

02364792 (323018)

e System symbols, defined in SYS1.PARMLIB(IEASYMO0O) can now be filtered by use of the LPARNAME
entry. See INITSYS.JCL in the jcl-symbols examples.

(387029)

Micro Focus Academic Program 9.0 - Release Notes

23



24

» Security for loading utility programs, either supplied by the user or any Micro Focus utilities, has been
increased. Users can now specify a number of libraries that hold program modules and who can use
them. See JCL Enhanced Security Checks in the product Help for more information.

PSEC:103014 (86177)

* When a dataset is required by MFFTP to be sent (put) or received (get), then MFFTP issues a dataset
lock that remains in effect until the end of the step. The location of the physical files used by MFFTP are
also validated against the PHYSFILE rules (if implemented). This access validation could cause security
errors if access is not allowed to the location of the FTP input and output file and might require that the
location be changed. This is usually the default allocation location, but may also be specified by
MFFTP_TEMP_DIR, or by adjusting the PHYSFILE rules to accommodate the location.

02210700 (244030)

» A step running IKJEFTO1 was incorrectly returning the highest return code of all commands executed
instead of the return code of the last command executed. The MF_IKJEFT_KEEP_MAX has been
added to correct this problem. Its default setting is MF_IKJEFT_KEEP_MAX=N. However, if the new
behavior leads to a change in the COND CODE, and this is a problem for your application, you can
return to the original behavior by setting MF_IKJEFT_KEEP_MAX=Y.

02532126 (415094)

« When the return code from an IKJEFT step exceeded 4095 it could be incorrectly adjusted depending
on the IKJEFT program called. To remedy this, the return code when IKJEFTOL1 is called is changed to
12. Also, when IKJEFT1A or 1B is called, the return code is adjusted to RC modulo 4096.

02514544 (406145)

« DSNRLI return codes did not always correctly reflect the outcome of the SRRCMIT and SRRBACK
functions. This has been fixed.

(408001)

* When the result of a SRRCMIT or SRRBACK call was a MIXED status, meaning that some XA modules
committed or rolled back and some did not, then DSNRLI issue either commit or rollback upon
shutdown at the end of the step. This was incorrect. DSNRLI will not NOT issue commit or rollback at
step end. The XA Recovery processing maybe able to recover the ‘'in doubt' transaction.

02512717 (406089)

« MFFTP has been enhanced to pass relevant file transfer information for FTP operations such as PUT,
GET, and DEL, to a user exit defined by the new environment variable, MFFTPXIT. To enable the exit,
set MFFTPXIT to a user-exit program file, for example, the provided MFFTPXIT.cbl sample file. A list
of valid parameters is in the provided mFftpxit.cpy copybook. When the user exit is enabled and an
FTP step returns a non-zero code, a copy of the * _op FTP output file is created using the * _out
extension in either the defined MFALLOC LOC or MFFTP_TEMP_DIR location. Use the *.out file to
determine the cause of FTP operation failures.

02287628 (259117)

Micro Focus Directory Server
Back to the list

* The External Security Manager (ESM) checks did not occur when an enterprise server region started or
stopped. This has been fixed.

02402188 (355001)

« To query Enterprise Server security configuration information (details of configured external Security
Managers and so forth) from the Micro Focus Directory Server when access is restricted, the authorized
Enterprise Server user must have at least Read permission for the Enterprise Server Administration
resource class User Administration entity.

(285199)

« Micro Focus Directory Server now restricts access to enterprise server regions that a signed-on user is
not authorized to view.
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02305916 (285169)
Four new MFDS-only audit event codes (2 300, 2 301, 2 302, and 2 303) have been added. See Audit
Event Codes in your product Help for more information.

02412285 (365149)

PL/I Support

Back to the list

When assigning a PICTURED item into a FIXED DECIMAL, FIXEDOVERFLOW is now triggered if
enabled and the target source or precision is not large enough to fit the PICTURED representation.

(400099)
The Open PL/I compiler erroneously allowed OFFSETVALUE(POINTER)), hamely
offsetvalue(sysnull()). The correct usage is: offsetvalue(binarvalue(sysnull())).

(386070)

The internal consistency error in the PUT EDIT statement with a DO-loop that was never iterated has
been fixed; however, we recommend avoiding dead DO-loops in PUT EDIT statements as they result in
redundant code.

02518315 (407194)
The Open-PLI compiler now performs Restricted Expression Evaluation on AUTOMATIC, DEFINED,
and BASED declarations in addition to STATIC declarations as in previous releases.

00368483 (11358)
The OPTIONS and LIMITED attributes now imply type ENTRY to correct a problem wherein type was
not specified and the default type was set by applying the I-N rule to the variable name.

02048549 (165087)
The behavior of the PRECISION built-in was incorrect for most data types, except FIXED BIN, FIXED
DECIMAL, and PICTURE. This has been corrected.

(363237)

When passing an array argument to a procedure with differing array dimensions or extents of the
corresponding parameter descriptor, a dummy argument was created. To correct this, a Severe
diagnostic message is now generated instead. In addition, when an array argument with variable
extents was passed to a procedure whose corresponding parameter descriptor had constant extents, a
dummy argument was created. To correct this, the array argument is now passed by reference and a
Warning diagnostic is generated. Both of these issues apply to passing arrays without surrounding
parentheses.

02310772 (286006)

Previously OPTIONS(FETCHABLE) was not implied by the coding of a RELEASE statement for an
ENTRY. This has been fixed.

01862366 (120035)
Data exception 8097 now occurs when the sign nibble of a fixed decimal value does not contain a valid
sign Ox0A thru OxOF during an arithmetic operation, conversion, or assignment.

02198788 (222107)

Run-Time System

Back to the list

By default, CTF information no longer appears in AUX Trace of an enterprise server region. To enable it,
you now need to set mFtrace.emitter._es#level in the MFTRACE_CONFIG.

(328008)
Previously, .NET COBOL applications that use OpenESQL/ODBC could fail to run with a license error
when deployed to a COBOL Server. This has now been fixed.
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02490119 (406153)
» If an error occurs during thread clean-up, the runtime will now attempt thread clean-up again. If it fails
for a second time the runtime will call _exit() to terminate the process immediately.

02286519 (258130)

« Attempting to call COBOL functionality after calling the cobtidy() API, to de-initialise the COBOL
RTS, will now result in a COBRT090 error message. Previously it was documented that the results
were undefined and it could cause subsequent problems, and/or errors, especially in a threaded
environment. The aim of this change is to give a more meaningful error message, earlier, to help
diagnose such issues.

(301136)

e The limit for the MAXGENERATION emitter property (for both BINFILE and TEXTFILE) has been
increased from 10 to 100. The file size limit for each of these generations, as set by the MAXFILESIZE
property, is 1000000KB.

02405466 (359001)

Setup Issues (Windows)
Back to the list

» Micro Focus Host Access for the Cloud emulator replaces the Micro Focus Rumba+ Desktop emulator
previously supplied with the installer for Enterprise Developer for Eclipse or Visual Studio. Customers
that have Rumba+ Desktop entitlement can continue to use it within Rumba+ Desktop.

(335003)
* In Windows 11 it is now possible to open COBOL 32-bit and 64-bit command prompts from the Terminal
application.

(421016)
* On Windows, you must uninstall earlier versions of this product before installing 9.0.

(380028)
» 32-bit Windows is no longer supported.

(382034)

Visual Studio IDE
Back to the list

* Inthis release, new native COBOL and PL/I projects in Visual Studio are configured to build on both x86
and x64 platforms. If the project is added to an existing solution, the build target configured for that
solution will be used. For new solutions, the x64 targets are always selected by default. This change in
behavior does not apply to Dialog System projects or imported 32-bit Net Express projects. There are
some known limitations of x64 templates - e.g., Assembler is 32-bit only, so users will need to set the
correct platform. Some templates remain 32-bit only.

(409099)

Known Issues

Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:

« An issue with the Call method in the COBOL RunUnit class prevents it from being used when you target
the .NET Framework. A fix is going to be available with Patch Update 1 of this release. This issue does
not affect .NET 6.
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.NET COBOL projects only support Windows and Linux OS. The Create a new project dialog box in
Visual Studio, however, shows other platforms as supported.

« If, after installing the product for Visual Studio 2022, you cannot access the Micro Focus functionality,
execute the following command from a Visual Studio command prompt:

devenv /updateconfiguration
e The Server Core form of Windows Server 2019 is not supported.

* In Visual COBOL 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur with
running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Visual COBOL 3.0 or earlier, then executed in Visual COBOL
4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Visual COBOL 6.0 and later, the .NET COBOL and JVM COBOL run-
times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a version
5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue, you need
to recompile any programs that use this construct in the newer versions of Visual COBOL.

Program that do not use NATIONAL data, or those that have been recompiled in Visual COBOL 6.0 or
later are not affected.

« The ChangeMan Attachment models of release 5.0 and earlier are not working in the expected manner
under Enterprise Developer 8.0 or later. This is a result of several tools that are called with a static
value="*" in the input parameter CMG_PROP_STATIC_SUBSYSTEM. If you want to run a ChangeMan
attachment model 5.0 and earlier under Enterprise Developer 9.0 you must remove the static value="*
from all CMG_PROP_STATIC_SUBSYSTEM input parameters.

Installation

System Requirements

Hardware Requirements

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.

Visual COBOL and Enterprise Developer for Visual Studio

Visual COBOL and Enterprise Developer have the following requirements in addition to the requirements of
Microsoft Visual Studio. See the Visual Studio documentation for details of the Microsoft requirements.

The disk space requirements are:

Product Maximum Disk Space Sentinel RMS License Manager
Requirements

Visual COBOL 1.2GB 75MB
Enterprise DeveloperEnterprise 2.3GB 75MB
Developer
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Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Visual COBOL and Enterprise Developer for Eclipse on Windows

The disk space requirements are:

Product Maximum Disk Space Sentinel RMS License Manager
Requirements

Visual COBOL 3.7GB 75MB

Enterprise Developer 4.5GB 75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported

Note: If you are using Visual COBOL or Enterprise Developer on a 64-bit operating system, you can
produce either 32-bit or 64-bit applications.

For a list of the operating systems each individual product in this package supports, check the Supported
Operating Systems and Third-party Software section on the Micro Focus Customer Care Web site. For
example, https://www.microfocus.com/documentation/enterprise-developer/ed90/ED-Eclipse/
GUID-7ECA1D86-EC87-454D-B666-1047527FD9BF.html.

Software Requirements
f Note: This product includes OpenSSL version 3.0.

Windows

Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

Visual COBOL and Enterprise Developer for Visual Studio:
You must have Microsoft's Visual Studio 2022 version 17.4 or later installed in advance.

You need one of the advanced versions of Visual Studio listed below:

Professional, Enterprise or Community Edition - see the next section for the Visual Studio components
you must install.

Microsoft's Visual Studio Express Edition is not supported.
/1, Important:

» When installing Visual Studio, ensure you select the Help Viewer component for installing if you
want to view the Visual COBOL product help inside Visual Studio. When you select components to
install in the Visual Studio installer, click Individual components and check Help Viewer in the
Code tools section.

The following software is also required:

* Microsoft .NET Framework 4.7.2. This is included with Visual Studio.

Visual COBOL and Enterprise Developer for Eclipse:
The following requirements apply to both Visual COBOL and Enterprise Developer:
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A 64-bit Windows is required. 32-bit Windows is not supported. See Installation in Known Issues and
Restrictions.

The setup file installs Visual COBOL and the 64-bit version of Eclipse 4.24 (2022-06).

Visual COBOL only supports the 64-bit version of Eclipse. You can use the 64-bit Eclipse to create both
32-bit and 64-bit applications.

The setup file installs Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot.
The setup file also installs Microsoft's Visual C++ 2012 and 2015-2022 Redistributables.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Java 11 (64-bit) or later is required to run the Eclipse IDE. The recommended version is Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Windows, the installer automatically installs Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. You can download Adoptium's OpenJDK Temurin 17 (LTS)
with HotSpot from Adoptium's Web site and unpack the archive anywhere on your machine.

Visual COBOL requires a 64-bit Java installation to run a 64-bit Eclipse.

Microsoft Windows SDK and Microsoft Build Tools: Various actions and operations within your COBOL
development environment depend on certain files that Microsoft distributes in the following package: the
Windows SDK package. See Microsoft Package Dependencies for a full list of actions and operations
that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location,
use the cbImx™s command line utility post-installation to manage this; see Managing the Microsoft
Build Tools and Windows SDK Packages for more information.

Installation Restrictions and Requirements

Before starting the installation you should be aware of the following:

Visual COBOL and COBOL Server cannot coexist on the same machine.

Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation. Also, the Visual Studio Help Viewer must not be opened.

You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

Downloading the Products

1. Use the download links in the Software Downloads section of the Micro Focus Software Licenses and

Downloads Web site.

Installing the Products

Use the individual setup files to install each product from the Micro Focus Academic Program package as
follows:
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Windows

1. Run the pr oduct namne .exe file and follow the wizard instructions to complete the installation.

2. After installing the Visual Studio 2022 product, if you cannot access the Micro Focus functionality, you
need to execute the following command from a Visual Studio command prompt:

devenv /updateconfiguration

After Installing

Visual COBOL and Enterprise Developer for Visual Studio

You are now ready to run Visual COBOL or Enterprise Developer. You need to start the version of Visual
Studio for which you have installed this product. By default, the Help is available online on the Micro Focus
SupportLine Web site: https://www.microfocus.com/support-and-services/documentation/.

To see the Help:

e Click Help > Micro Focus Product Help > Product Documentation.
* Alternatively, press F1 inside the editor or from a Ul part.

This opens the Visual COBOL help or Microsoft's MSDN depending on which keyword in the editor or
part of the Ul you are querying.

Note: Your Visual Studio might be configured to show the local help. To switch to online help, click
Help > Set Help Preferences > Launch in Browser inside Visual Studio.

Refer to the Welcome and Product Information sections in your product Help. Here, you will find information
on getting started including tutorials and demonstration programs.

Visual COBOL and Enterprise Developer for Eclipse

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.

Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open
Perspective > Other.

3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.

5. Click Window > Perspective > Reset Perspective.

6

7

n

. When prompted, click Yes.
. Reapply any customizations.

To view the help:

* Click Help > Micro Focus > Product Documentation.
* Alternatively, press F1 inside the editor or from a Ul part.

This opens a browser with the Visual COBOL help.

Note: By default, Eclipse is configured to show the local help. See the installation notes within the
product Help, for instructions about how to switch to local help.

Refer to the Welcome and Product Information sections in your product Help. Here, you will find information
on getting started including tutorials and demonstration programs.
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Repairing

Windows

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

1+, Important: Before performing a repair of the installation, Micro Focus recommends that you create
“* packups of any configuration files of the product that you might have changed.

To repair your installation:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

UNIX

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Before performing a repair of the installation, Micro Focus recommends that you create backups of any
configuration files of the product that you might have changed.

Uninstalling

Windows
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed. If the installation installed the Microsoft Windows 10 SDK or Microsoft Build Tools
packages, these are left in place, although the Micro Focus-related registry entries for these packages are
removed.

If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.

Note: The installer creates separate installations for Visual COBOL, Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Visual COBOL does not
automatically uninstall Enterprise Server for .NET, the Micro Focus License Manager or any of the
prerequisite software.

Enterprise Server for .NET must be uninstalled before you remove Visual COBOL. To completely
remove the product you must uninstall the Micro Focus License Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

e« Micro Focus Product Nane folder in the Start menu - you can delete it manually.

« Ysystemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log
files of the samples which you have built.
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* %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
 %Program Files%\Micro Focus - you can delete it manually.

Copyright and Disclaimer

© Copyright 2023 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS 1S" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party Web sites take you outside Micro Focus Web sites, and Micro Focus has no control
over and is not responsible for information on third-party sites.
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